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Starting Out

Interacting with Outlook

Now that we know how to open and close Outlook, we’re going to look at using some of
the elements on the main screen, including menus, shortcut keys, and dialog boxes.

The Outlook Interface

Before we get too far, let’s take a look at the different components of the Outlook

interface. Here we’re viewing the Mail folder, just because it’s the first folder that you
will see when you open Outlook. The interface will be slightly different for each folder
that we look at, but the basic components will remain the same.
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9.

Title Bar

Menu Bar

Type a Question

Toolbars

Navigation Pane

Inbox

Preview/Reading
Pane

To-Do Bar

Status Bar

On the left hand side, the title bar displays the title of the
document you’re working on and the name of the
program. To the far right of the title bar, you have
buttons to maximize, minimize, restore, or close the
window.

You can click on any of these items (File, Edit, View, Go,
Tools, Actions, or Help) to view a list of commands.
(We'll talk more about using menus in a moment.)

If you need help, type a question in this box, press Enter,
and answers will appear in a new window.

This is the Standard toolbar. Outlook has three toolbars:
Standard, Web, and Advanced. We'll discuss all of them
in the next lesson.

This pane is the easiest way to get around in Outlook. It
contains links to various folders so that you can easily
view your contacts, mail, calendar appointments, and
more. We'll discuss this pane in Lesson 1.4.

This is where all your new mail will appear. And, no
matter what folder you’re in, you will see its items in this
central pane (although the pane may be a different size).

View the contents of the selected item here.

This is a new feature in Outlook 2007. It is visible in all
folders except the Calendar folder. It summarizes
upcoming tasks and appointments.

Displays item count for the current folder.

Understanding the Two Interfaces
As we just saw, when you open Outlook, you will see the older style interface with
menus and toolbars:
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However, if you start working with Outlook items, you will see an entirely different

interface. This interface uses a ribbon system, where you click the tab for the commands

that you want to see.
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This is the interface that most of the Office 2007 applications use. We'll cover both
interfaces in depth as we discuss the topics.
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Using the Outlook Panes

Using Outlook Today
Outlook Today is your home page when you’re using Outlook 2007. To display it, click on
Personal Folders in the Navigation Pane (it’s at the very top of the list of folders).

Mail «
Favorite Folders =
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L Unread Mail
L Far Fallaw U
L= sent Items
Mail Folders =
L] All Mail Tiems -
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= & DeletedItemI%
L7 Drafts [1]
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Outlook Today will show you not only the date, but also appointments for that day;
tasks you have created; and e-mail messages that are in your inbox, drafts, and outbox.
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Using the Navigation Pane

The Navigation Pane allows you to move between folders through Outlook and provides
tools for working with those folders. For now, we’ll focus on what the pane looks like in
mail view. When we look at particular folders later on, we’ll look at the various tools.
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Using the Reading Pane
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The Reading Pane (also known as the Preview Pane) will show you a preview of the

currently selected item.

3 Inbox |

Arranged By: Date

Mewest an top |

=) oider

=4 Susan Harris 271372007
Accounting Report 1

=1 Susan Harris 271372007
Upcaming Staff Party

(=1 Micrasaft 10/13/2005
Canadian TechMet Flash: Special Events Edition - Launch 2007

(= PowerPaint User 6212008 )
Please review 'Lesson 4.1 1]

Upcoming Staff Party

Susan Harris [welsoft@modomail.com)
Sent Tue 2/13/2007 11:36 AN
Tor  velsoft@modomai. com

Hi Sam,
Do you have an estimated date for the next staff function?
Thanks,

Sue

You can control the location of the pane using the View menu.
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Using the To-Do Bar

Arrange By k
Current Wiew k
AutoPreview

Expand/Caollapse Groups »

Mavigation Pane k

To-Dao Bar k

Reading Pane [:'S ¥ |15 Right
Reminders Window El Eottom
Toolbars 3 J_El oOff
Status Bar

Refresh F&

The to-do bar is a new feature in Outlook 2007. Visible in all folders except the calendar,

it provides quick access to upcoming tasks and appointments.

The top section shows the current calendar month and upcoming appointments.
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To-Do Bar »ooX

4 Movemnber 2007 4
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Charity Dinner
6:00 PR - 9200 PM
TE&

Staff Meeting
Fri 12:00 P - 1:00 PM
Boardroam

You can use the arrows to navigate through the calendar months, or you can double-
click an appointment to open it in your calendar.

The bottom section provides tools for tasks.

Arranged Byi Due Date

Arrange cate ring|

=1 % This Week

Prepare rep...

Sending E-Mail

Composing E-Mail

In the last lesson, we got a brief look at the message window. In this lesson, we’re going
to take a closer look at the tools available to you when creating an e-mail.
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Creating a New Message

There are a few ways to create a new e-mail message. The easiest is to click the New

button on the Standard toolbar while in a mail folder.

B ﬂew[}\%

-;i-_—.i:l-“ ><

~&PReply (=8 Replyta &)l (3, Forward

|New b ail Message|

You can also click the File menu, choose New, and choose Mail Message. There is also
the Ctrl + N shortcut.

5

e

I e
Qpen
Clase All Items

Save A5

Sawve Attachrments

Folder

Data File Management...

Import and Export..,

Archive,.,
Page Setup
Print Prewiew

Print...
Wark Offline

Exit

Ctrl+P
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Mail Message
Pastin This Falder
Faoldet...

Search Folder...

Crl+ M
%trh Shift+5

Ctrl+ Shift+E
Ctrl+ Shift+ P

Mavigation Pane Shortcut..,

Anpointment
heeting Regquest
Contact
Distribution List
Task

Task Request
Journal Entry
Mote

Internet Fax

Choose Form,.,

Choose InfoPath Farm...

Outlook Data File...

Ctrl+ Shift+ 2
Ctrl+ Shift+ 0
Ctrl+Shift+C
Ctrl+ Shift+L
Ctri+5hift+E
CErl+ Shift+ U
Ctel+ Shift+ ]
Ctrl+ Shift+ M
Ctrl+ Shift+X

Ctel+ Shift+T
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With any of these actions, you will see this window.

Cia = I RN Untitled - Message (HTRL)
) —

) ———
k | Message { Tnsert Options  FormatText

Cut = i P -
e coniso - [ B E oy m) e SR | A
23 Copy ¥ High Impartance
FPaste ‘B I u||ﬂ£?~ AV Address Check | Attach Attach Business Calendar Signature | Fallow Spelling
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Clipboard o Basic Text o Hames Include = Options ™= || Proofing
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The Message Interface

Let’s take a closer look at the window we see when we create a new mail message.

=~ =] ,2:
1 Message Thsert Options Format Test 4

B Sk CalibriBo - 11 = | A" A7
44 Copy

Paste

| |37 ~ -
Frormatpanter | B 4 U v - A=

Clipboard T} Basic Text

Subject:

S5 £E|| Address Check Attach Attach Business Calendar Signature  Follow

3untiﬂed - Message (HTML) - =

DI AR BN R=RE Al dhri

¥ High Importance

® "

Spelling
Book  Mames File  Item  Card~ Up~ | # lowImportance -
] Wames Tnclude Optians 1 || Proofing

1. Office Menu

2. Quick Access

toolbar
3. Title Bar
4, Tabs

5. Address fields

6. Editing Window

Outlook Email Basics

6

5

Click the Office logo to see commands for working with
your message, including saving, sending, moving, deleting,
and protecting it.

Contains icons for frequently used commands. (See Lesson
2.4)

Shows the title of your message and the format being
used. At the far right, you have buttons to minimize,
maximize, and close the window.

Commands are stored in the various tabs. So, to insert an
item, you would click the Insert tab and then click the
item. (See Lesson 2.3 for more information.)

Type your recipients’ addresses here. You will also find the
Send command here.

This is where you will type your message.
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Adding Recipients

To choose who to send your message to, simply type the address in the proper field.

joe@acrne, com;
SUEI@ACTNE, COM
Bre... roger@xy2, Ccom

Here’s a quick overview of the three address fields:

To Messages are addressed directly to these recipients.
CC Messages are copied to these recipients.
BCC Messages are copied to these recipients, but their address is not visible

to other recipients.

If you have sent a message to this recipient before, you may see a small menu pop up as
you are typing.

;
SUSIICE, Com
z

Simply use the down arrow on your keyboard to choose the correct entry and press
Enter to accept it. If the entry is not correct, just keep typing and ignore the menu.

Address lookup options
1. Start typing portion of name first or last doesn’t matter. Then click the check
names button or enter Crtl+K (will produce a short list of names that meet
the criteria entered regardless of character placement example: firstname or
lastname if you use Holl you will get both Holly and Hollenbeck))

2. Start typing and an address appears in a quick list. This is the names cache
this is stored on your local hard drive, this is NOT doing a search against any
address book so make sure if the address is one you want to keep it is saved
to your Contacts.

3. Click the To: button and browse an address book, the Global Address Book

(GAL) (equal to the Novell GroupWise Address Book) or one of your Contacts
Folders.

Outlook Email Basics C1



Typing a Subject Line

The next item that you will need to fill out is the subject line.

Tau. | SUEIDACIE, COm;

- rogeri@ye, com;
Send

Bre...

ISuh_iect: Upcoming Staff Meetingl

Typically, this will be a five to ten word line explaining what the message is about.
Simply type your text in the area shown in the image above.

Creating Your Message

To create a basic message, all you have to do is type in the white area.

(N ) s Upcormning Staff Meeting - Message (HTML) x
a =
- Message Insert Options Format Text L7
= Cut ol Y gl = Permission ~
B u CalibrifBo = 11 = | A A ] ﬂ MJI @ @J QJ Tl“ /39 Vv L Permission v

Copy - ¥ High Importance
Paste B I u|®- A= Address Check | Attach Attach Business Calendar Signature | Follows Spelling
- Format Fainter = == Book Names || File  Item  Card~- i Up- | B lowImportance -
Clipboard i) Easic Text i) Names Include Options % || Proofing

This message has not been sent,

g roger@:xyz.com;

Send

Bec..
Subject; | Upcaming Staff Meeting

i)

Hi Sue, a

Can you please remind your staff about the meeting at 9 am Friday morning?
Thanks,

Saml

However, Outlook uses Microsoft Office Word 2007 as its e-mail editor, so there are

many more features that you can add to your message. First, let’s look at the Basic Text
group on the Message tab.

Calibri(Bo ~ {11~ | A" A7|[3= - 1= |25

B;ual_:;,é.

Basic Text ]

Here, you can choose the face, size, color, alignment, and appearance for your font.
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To add other Word elements, such as pictures, charts, SmartArt, ClipArt, and text boxes,
look at the Insert tab.

!-’/ ‘g\'.: H9 0 «v )5 RE: Accounting Report - Message (HTML)
—/ Message Insert% Qptions Format Text

=2 ®Em 2 ALWBE 2@ 2 A4 T =

53 Date & Time

Attach Attach Business Calendar Signature Table Picture  Clip  3hapes SmartArt Chart Hyperlink Bookmark Text  Quick ‘Wordark ¥ Equation Symbol Horizontal
File  Ttem  Card~ - - Art - Box+ Partsw - ‘4 Object - - Line
Include Tables INustrations Links Text Symnbiols

Many of these features are offered with Microsoft Office Word 2007, so for more
information on using them, refer to Word help.

The last option we’re going to look at is changing the background color of your mail
message. To do this, click the Options tab, click Page Color, and choose a color.

-"E;%\\ Hd9 bty ¥ Upcoming 5taff Meeting - Message (HTML) - =
T

®

Message  Insert | Options | FormatText

B colors ~ j §— g AapainTest 0,0 =l O
mev ] =4 i= ’m A Request a Delivery Reczipt Y —3 &

Themes Page ||| Show | Show Use Woting [~ Request a Read Receipt Sawe Sent Delay  Direct
- @Effmf = licalar+ Bee | From || AeRich Text || Buttons~ Ttem~  Delivery Replies Ta
Themes Theme Colors rmat Tracking & More Options &

[
.|||||||||

This message has not
—
=

EEC Standard Colors
supjec; | EEEEE
Mo Color
Hi Sue, More Calars..,
Eill Effects...

Can you please refrmoroarstarrasoaerrerreeting at 9 am Friday morning?
Thanks,

Sam

—— =

Watch your message change as you mouse over the various colors! When you find a
color you like, click it to apply it.
When you’re all done with your message, click Send.

a

NCLIE
il

Message | Insert  Options  FormatText

Upcoming 5taff Meeting - Message (HTML) - a

® x

= . cut

B calibriBo 11 < AT A7 =] ﬂ %'/"I @ ) Q:' ﬁn %" ? =3 Permission ~ %
23 Copy - ¥ High Impartance
Faste ‘B I ul®- A= Aftach Attach Business Calendat Signature | Follow Spelling
- F Format Painter = L] Baalt  Emes File  Remn Gendle - Up~ | & LowImportance B
Clipboard & Basic Text & Hames Include Options 7 || Proofing

This message has not been sent,

[ro. | |suemarme.com;

=1

Send

[ cen | [romer@sre.com;

(o] |

Subject: ‘Upcnmir\g Staff Meeting

] v [

Hi Sue,
Can you please remind your staff about the meeting at 9 am Friday morning?
Thanks,

Sam

&
ol 1 I

ALK
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Using the Drafts Folder

In the past few lessons, we’ve created messages and sent them right away. However,
there may be times when you need to save a message for later editing. Luckily, we have
just the tool for you: the Drafts folder. This is where you can store incomplete messages

and edit, delete, or send them later on.

Opening the Drafts Folder
To view the contents of your Drafts folder, simply click it in the folder list.

(v Drafts - Microsoft Outlook -
File Edit Miew Go Jools Adions  Help Type a question for help [+

GiNew - | @& 3 X | g Reply 58 Repli to &)l Foruard L | [ send/Regeive + (9 | [ Searchaddressbooks  + | @) -
Mail « ||z Draftsl [ ERas Upcoming Meeting To-Do Bar » X
Favorite Folders % || Arranged By: Date Mewest on top ‘ MNowvember 2007

SM TW T F S

[ Inbox P
- 7] BRI nOE e ors This message has not been sent,
O Unpead Maif Upcoming Mesting 12 3
3 For Foliow Up None 4[5 6 7 8 910
(=] sent Ttems welsoft@modomail.com 11 12 13 14 15 16 17
o ; DoDe e @)
O] a1l Mail kems - 1 =
. Hello Joe, e —
=) 5 Personal Folders Charity Dinner
Deleted Tterns 6:00 PM - 5:00 PM
Emaﬂs I am thinking of scheduling our production meeting next TEA ‘
4 DAEE 5 e —
12 nbox [% Tuesday at 9 a,m, What do you think? SfiMecting
[ Junk E-mail [1] Fri 12:00 P - 1:00 PM
5] Cutbox Thanks, Boardroom
[ RS Feeds
Sue

L= sentItems
# Lg Search Folders

The number in green next to the folder indicates how many items are in it.

Saving a Message as a Draft
By default, Outlook saves messages to the Drafts folder every three minutes. This really

comes in handy if your computer blows up while you’re typing a message! If you want to
save your message manually, however, you can press Ctrl + S, click the Office menu and
click Save, or use the Save command on the Quick Access toolbar.
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Create Mew QOutlook Item
Mew Mail Message

S 1 Mail Message
send :E 2. Appaintment
_j 3, Meeting Request
LE 4, Contact
Sawe
- % & 5, Distribution List
< 6 Task
Sawe Az [ 2 J -
E 8. Choose Form
Delete @} 8. Choase InfoPath Form

4l

Mowe » E o —

g d ol e X AL 1] &

Permission »
Print »
Properties

LClose

3] Editor Cptions

Answering Mail

In our last section, we learned how to work with messages and how to use the new
2007-style interface. In this section, it’s time to get to the real fun: answering your mail.
In this lesson, we’ll learn how to reply to messages, forward messages, open and save
attachments, and use the new Attachment Previewer.

Opening and Saving Attachments

Often, if someone is sending a long document or a file that can’t be copied and pasted
into an e-mail message, they will attach the file itself. You can tell if a file is attached by
the paperclip icon in the message list.
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L Inbox

Arranged By: Date

Mewest on top |

= Older

|} Susan Haris 2/13/2007

: Accounting Report

=4 Susan Harris 21372007
Upcaming 5taff Party

i~ Microsoft 10719720086

Canadian Techiet Flash: Special Events Edition - Launch 2007

i1 PowerPoint User
Please review 'Lesson 4,1

EIEUEDDEI ‘3

If you look at the message in the Reading Pane, you will see that a file is attached.

LY Inbox | Pl

Please review ‘Lesson 4.1°

Arranged By: Date Mewest an top

| PowerPoint User [powerpoint@modomail .com]

P e,

= older

i Susan Harris 211372007
Accounting Report

(=1 Susan Hatris 2/13/2007
Upcoring Staff Party

(=1 Microsoft 10/19/2006

Canadian TechMet Flash: Special Events Edition - Launch 2007

Sentt Wed /2172006 11:56 AM
Tos ‘powerpoint@modomail, com'

o] Message lﬂjLesson 4.1.ppt (409 KEB] I

Flease review the attached document.

3 PowerPoint Lser Bf21/2006
Please review ‘Lesson 4.1 m

You can right-click on the file to see options.

Please review ‘Lesson 4.1'

PowerPoint User [powerpoint@modomail.com]

Rewiewy,

Sentt Wed 6212006 1156 AM

T 'powerpainti@rodarnail, com'

Flease review the attad

Prewiew
Dpen
Print
Save A5,

Femove
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Doing More with E-Mail

In our last lesson, we learned how to create a basic e-mail message. In this lesson, we’ll
learn how to use some more advanced features, including attaching files and items,
adding hyperlinks, and using themes.

Adding Attachments
It's easy to add an attachment to your message. Just click the Insert tab and click Attach

File.

Tp) * ¥ F Untitled - Message tHTML)
g Message Insert; Options Format Text (7]
(oM |y & EHBP Dl Q@ 3 EE 48T Qs
Attach | Attach Business Calendar Signature || Table | Picture Clip  Shapes Smartirt Chart | Hyperlink Bookmark || Text Quick Wordart = Equation Symbal Harizantal
F[:é Item  Card~ ~ - Art - Box~ Parts~ v '9d Object - - Line

Include Tables lllustrations Links Text Symbaols

Attach File

Attach afile to this item,
Brc..
Subject:

Receiving E-Mail

The New Interface — Part | the Ribbon

In our last lesson, we got a glimpse of the 2007-style interface that Outlook uses when

creating and editing items. In this lesson, we’ll take a closer look at it.

[ ngn\' = 7 Accounting Report - Message (HTML) x
_e.y Message (7]

S KA D Gem B WY B g

Reply Reply Forward —Delete Moweto Create  Other Block Mot Junk Categorize Follow Mark as Send to

o &l Folder= Rule Actions = || Sender - Up~ Unread || 4 Select= Oneblote

Respond Actions Junk E-mail El Optians a Find Onehlote
From: Susan Harris [velsoft@madomail, com] Sent: Tue 2/13/2007 11:36 AM
Tan: welsoft@madomail, com
o
Subject Accounting Report

-
Hi James:

Just a reminder that | need those figures by the end of the day today!
Thanks,

Sue

About Tabs
The ribbon interface used by most of the Office 2007 system changes depending on

what kind of object you’re creating. It also ensures you see only the commands that are

most applicable to what you’re doing, as the various sets of commands are accessible
using the tabs.
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RE: Accounting Report - Message (HTML)

i
— | Message Insert. Options FurmatTextI

_1 Calibri(Bo ~ 11 - | A°
Copy

 Format Fainter

¥ High Importance

‘B r ull®- A ||| Address Check | Aftach Attach Business Calendsr Signature | Fallow Spelling
= = Book Mames | File  Item Card~ - Up~ | & lowImportance -

) ﬂ @1 @ J@ i‘ ﬁ Z Yr 54 permission ~ {&Q

Clipboard i Basic Text Hames Include Options ™ || Proofing
Susan Harris <velsoft@modomall.com:
—
send
Subject: | RE: Accounting Report
)
| -
From: Susan Harris [mailto:velsoft@ modomail.com]
Sent: Tuesday, February 13, 2007 11:36 AM
To: velsoft@modarmail.com
Subject: Accounting Report
Hi James:
Just a reminder that | need those figures by the end of the day today!
Thanks,
Sue
So, if you wanted to insert an item into your mail message, you would click the Insert
tab to see those commands.
(On) d - ¥ )7 RE: Accounting Repert - Message (HTML)
il
—/ Message Insert% Options Format Text
10) a= y Ellgl a0 h A j 4[ AS prop Cap A=
= Em 4 0O LWE 2 @ 2 AE S oate e U Q2 3=
Attach Atktach Business Calendar Signature Table Picture  Clip  Shapes Smarthi Chart Hypetlink Bookmark Text  Quick Worddr Equation Symbol Horizontal
File  Ttem Card~ - - Atk - Box+ Partsw v  '8gObject - - Line
Include Tables Tlustrations Links Text Symbiols
About Groups
Each tab is composed of groups of commands. For example, the Message tab has
Clipboard, Basic Text, Names, Include, Options, and Proofing commands.
Cn H9 ¥ RE: fccounting Report - Message (HTRL)
Y
—/ Message Insert Options Farmat Text
= L Cut - RN 23 ﬂ@] U] = & Permission ~
CalibrifBo ~ 11~ |A a7 |:i= - i= 'I|5”'| ﬁ @ o y
) Copy = V’ J J ﬁ ¥ High Importance
Paste X ‘B I Ul A= :=|  Address Check Aftach Aftach Business Calendar Signature | Follow Spelling
~ . Farmat Painter = - || = E Book Names File  Item Card~ - Up- | § lowImportance -

These separations are useful and can help you quickly and easily find commands.

About Option Buttons
Some groups will have a small button in their bottom right hand corner.

Calibri(Bo = |11 ~ || A" A7 |[3= = i= - |||

B 7 u|w-A-|

[|£= £

Basic Text
Clicking this button will open a dialog box with more features related to the group. In
the example above, clicking the small arrow would open the Font dialog.
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The New Interface, Part 2 the Quick Access toolbar

Another aspect of the new interface is the Quick Access toolbar. This toolbar is right
next to the Office menu, just above the tab. It’s a place to store your most frequently
used commands, to save you from hunting around in the tabs. In this lesson, we’re going
to learn all about the toolbar!

41

N PR
3)

— Message Insert Qptions Format Text

Using the Quick Access Toolbar

By default, there are five icons on the toolbar.
= 9 & ¥ |5

From left to right, they are Save, Undo, Redo/Repeat, previous item, and next item.
Using the toolbar is as easy as clicking the icon!

Managing Folders

By now, you’re probably quite familiar with creating messages and working with the
default folders in Outlook. However, Outlook gives you the ability to create your own
folders to manage your mail. In this lesson, we’ll learn about creating, renaming,
deleting, and using folders.

Creating Folders
To create a new folder, you can click the File menu, choose New, and click Folder.

M e b5 Mail Message Chrl+ 1
Qpen r ‘;‘y Pastin This Folder Ctrl+5hift+ 5
Close Al Items 4 Folder. Ctrl+ Shift+E
Bl savess. LGl Search Folder.., Ctrl+ Shift+ P
Save Attachments * Mawigation Pane Shortcut.,
Eolder » :ﬁ Appointment Ctrl+ Shift+ A,
Diata File Management... :I Meeting Reguest Chrl+ Shift+ O
Import and Export.., L Contact Crl+ Shift+ C
Archive.,., ﬁ Distribution List Ctrl+ Shift+L

You can also use the Ctrl + Shift + E shortcut, or right-click a folder and click New Folder.
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Mail Folders
2] All Mail e ms

3

= @ Intermediate L
fa] Deleted e
L7 Drafts [1]
[ 7 Inbox 5]
L @ Junk E-mai
L= Outbax
L) RSS Feeds
[=F sent Items
H L Search Folg

ale

Qpen

Open in Mew Wind o
Bename "Intermediate Lewvel™..
Mews Falder...

Add to Favarite Folders
Process All Marked Headers
Process Marked Headers
Open Qutlook Data File...
Close "Intermediate Level”

Properties for "Intermediate Lewel”..

You will then see this dialog:

Create Mew Folder

Marme:

Folder conkains:

|Mail and Post Ikems

Select where to place the folder:

EREA] intermediate Leve
i Calendar
8=| Contacts
fa] Deleted Items
L7 Drafts [1]

3

[ 7 Inbox (5}

i 100rnal

L@ Junk E-mail [1]
o | Motes

L= Outba

L RSS Feeds

|

84

] [ Cancel

]

At the top, type a name for your folder. Then, choose what type of items you want it to
contain. Then, choose what folder you want to place it underneath. When you’re ready,

click OK.
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